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In This Guide...

This guide describes the concepts of Agilent OpenLab CDS ChemStation Edition.
In the following, the term ChemStation always refers to Agilent OpenLab CDS
ChemStation Edition.

In this manual we describe the efficient use of the data acquisition, analysis, and
reporting functions in OpenLab CDS ChemStation Edition C.01.70 to boost your
lab's productivity.

Table 1 Terms and abbreviations used in this document

Term Description

AlIC Agilent's Analytical Instrument Controller

CDS Chromatography Data System

ChemStation OpenLab CDS ChemStation Edition

Control Panel OpenLab Control Panel

Microsoft Control Panel Part of the Microsoft Windows operating
system

Secure Workstation Secure Workstation for OpenlLab CDS

ChemStation Edition

1 Basic Concepts of OpenLab CDS ChemStation Edition

This chapter explains the principles of working with ChemStation, including
remote control, the graphical interface and the ChemStation views.

2 Working with Methods

The method is a vital part of ChemStation, and this chapter explains the concepts
in detail.

3 Data Acquisition

This chapter contains an introduction to the process of acquiring data.
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4 Automation/Sequences

This chapter describes the concepts of automation. It explains how to work with
sequences in ChemStation, what happens when a sequence is run and how to
customize sequences.

5 Run Control

This chapter explains the concepts of Run Queue and Queue Planner. It explains
how to add single samples, sequences, pauses, or commands to the Run Queue.
It also describes the Command Scheduler in which you can schedule events to
make your everyday lab work easier.

6 Data Analysis and Review Concepts

You can analyze and review your data with OpenlLab CDS ChemStation Edition.
This chapter outlines the ChemStation data analysis and data review options.

7 Calibration

This chapter explains the concepts of calibration.

8 Reporting

This chapter describes the concepts of Intelligent Reporting and Classic
Reporting.

9 CE specific Concepts and Functions

This chapter is relevant only if you use ChemStation to control CE instruments.
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Basic Concepts of OpenLab CDS ChemStation Edition

Introduction

OpenlLab CDS ChemStation Edition provides full instrument control of Agilent's
LC, GC, CE, CE-MS and LC-MS instrumentation. It offers tools for data acquisition,
analysis and interpretation using a multi-technigue, multi-vendor instrument
control. Start the chromatography software from the OpenLab Control Panel,
where you access all functions provided by OpenlLab Shared Services.
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Basic Concepts of OpenLab CDS ChemStation Edition

About the ChemStation Software

Data Integrity

ChemStation files such as data, methods, or sequences are stored in various
local folders. To ensure data integrity, ChemStation offers the Secure File I/0
function. If you enable this function, all folders will be protected against
modifications from outside ChemStation or in Open or Save As dialogs.

For more information, refer to the Folder Protection with Secure File /0 chapter in
the OpenlLab CDS ChemStation Edition Configuration Guide
(CDS_CS_configure.pdf).

Central Data Storage

A central data storage system can hold all kinds of electronic data independent
of any proprietary data formats. ChemStation raw data (and other
human-readable documents, such as workbooks) are stored together with
metadata; this allows the data to be searched very easily. ChemStation methods,
sequence templates, report templates, and data files (sequences and single runs)
can be uploaded to the central repository, and later downloaded back into the
ChemStation if required.

Agilent provides two systems for central data storage:

+ OpenLab Server is available as a single-server solution providing centralized
data management for small to medium laboratories with up to 30
instruments. It provides the necessary security in support of regulatory
compliance. Please see Openlab Server documentation for further
information.

+ OpenlLab ECM is available as a single-server solution or a multi-server,
distributed solution for comprehensive data management needs for
laboratories with a few instruments to 100s of instruments. It also provides
the necessary security in support of regulatory compliance. Please see
Openlab ECM documentation for further information.

For more information on the concepts of ChemStation with central data storage,
refer to the Agilent OpenLab CDS ChemStation Edition with Central Data Storage
User's Guide.
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1 Basic Concepts of OpenLab CDS ChemStation Edition

With Secure Workstation for OpenlLab CDS ChemStation Edition, ChemStation
and OpenlLab Server with its Content Management module are installed together
on a single workstation computer. For more information on the Secure
Workstation, refer to the Secure Workstation for OpenLab CDS ChemStation
Edition Guide.

Methods and Sequences

The analytical method fully describes how a particular separation is performed. It
contains all parameters for instrument control, data acquisition and evaluation,
including integration, quantification and reporting. The system may be set up to
acquire data from a number of samples by different methods. The control file for
this sort of operation is called a sequence. It holds the individual sample
information, references to the appropriate methods, automatic recalibration
specifications, and reporting instructions for a summary report across all runs in
the sequence. For further information on methods and sequences, see
‘Automation/Sequences” on page 76 and the online help system.

System Configuration

The configuration of the instrument system is done through the OpenlLab Control
Panel which starts the configuration editor program. It allows you to define your
instruments, their LAN addresses, the directories for your data, sequences and
methods and the initial screen size of the ChemStation software. In addition, you
can activate or deactivate Intelligent Reporting and 3D Spectral Evaluation, and
you can define the method download options.

Acquisition Method Viewer

With the Acquisition Method Viewer, you can check the acquisition parameters
stored in a method, independently of the current instrument configuration. You
can choose to either apply this method in its original version to the instrument, or
to resolve this method against the current instrument configuration.
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Basic Concepts of OpenLab CDS ChemStation Edition

Method Download Options

The method download options define the behavior of ChemStation, if the last
selected method from the previous instrument session differs from the current
instrument settings. You can choose among the following options:

* Download method to instrument

The last selected method is downloaded to instrument. The instrument
settings will be overwritten. This behavior corresponds to ChemStation
revisions C.01.03 or lower.

+ Upload method from instrument

The instrument settings are uploaded into the last selected method. The
method will be marked as modified.

* New method from instrument

The instrument settings are uploaded into a newly created ChemStation
method.

+ Always ask user to choose an option

At ChemStation startup, a dialog is shown where you can choose on of the
options described above. In this dialog, you can also compare the instrument
settings for each module with the settings in the last selected method.

When comparing the differences, you can either display the entire list of
settings, or display only the differences.

Data Model

The ChemStation software is designed around a data model based on a memory
structure called a register. Registers are multipurpose structures that can hold
analytical data and information for both two-dimensional information (for
example, time/intensity) and three-dimensional information (for example,
time/intensity/wavelength).

ChemStation provides commands and functions to construct, expand, extract
and, where it does not alter primary data, edit registers. For further information,
see the online reference in ChemStation under Help > Commands.
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1 Basic Concepts of OpenLab CDS ChemStation Edition

File Naming Conventions

File Names and Tokens

In most of the ChemStation dialogs where you enter a path name or file name,
you can use tokens to dynamically generate suitable names. Depending on the
file or path name that is set in a given dialog, different tokens are available. In the
following screens, several tokens are used as examples.

The control for file names has the following appearance:

Choose token

Delete content

<SampleM ame: <Dates <Time> X_b—|

Tokens are displayed in blue color and with an underline
The control for path names has the following appearance:
Choose token
Browse for location

Delete content

|H<E0mguter>k|nstName>/1 Ko B

Tokens are displayed in blue color and with an underline

In each corresponding dialog, the resulting file name or path name is displayed
additionally.

You have the following options to work with this type of fields:
+ Add static text.
+ Click the Arrow button ( * ) to choose a token from the list.

Press the Arrow Down key to choose a token from the list.

+ Right-click one of the tokens already used to replace it by another token from
the list.

» Click the X button to delete the current content of the field.

+ Click the button with the three dots (*=+) to browse for the required path.
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1 Basic Concepts of OpenLab CDS ChemStation Edition

Naming Conventions

Make sure you only use the following characters for ChemStation items such as
file or directory names, names of sequence templates, or names of ChemStation
methods:

A-Z,a-z,0-9, _ (underscore), - (hyphen)

Check your names for leading or trailing blanks. They are not allowed, but are
easily overlooked.

If you use tokens, file names or directory names are automatically created based
on information such as instrument names, operator names, or sample names.
Make sure that these names follow the same naming convention.

Automatically created file names may include specific characters for Front and
Back injector location. These characters may be localized. They are valid even if
they are not part of the characters listed above.

The following reserved device names cannot be used as the name of a file. Also
avoid these names followed by an extension (e.g. Nul.txt):

*  CON, PRN, AUX, NUL
«  COMXx (where x is a number from 1 to 9)
« LPT1x (where x is a number from 1 to0 9)

English, Japanese, and Chinese operating systems are used to test naming
conventions. Agilent cannot give a support statement for non-English operating
systems and their special characters.

Maximum Length of ChemStation file names and subdirectories

The Agilent ChemStation specifications for file names and subdirectories are
listed below:
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Basic Concepts of OpenLab CDS ChemStation Edition

Table 2

DataFile/Subdirectory/Path

Data file name of single sample

Data file name in a sequence, using
prefix/counter

Data file name in a sequence, using a
name pattern

Method

Sequence

Libraries

Customized Report Templates

Data file subdirectory

Data sequence subdirectory

Data Path

Method Path

Sequence Path

Libraries Path

Customized Report Template Path

Max. Input
Length

60
60

60

60

40
40

149

Auto
append

D
.D

.UVL
.FRP

Maximum length of ChemStation file names and subdirectories

Example

Demodad.d

longname000001.d

05-1-sampleA.d

def_lc.m
def_lc.s
demodad.uvl
areapct.frp

demo (in sample information)

demo (in sequence
parameters)

C:\Users\Public\Documents\
ChemStation\1\data
C:\Users\Public\Documents\
ChemStation\1\methods
C:\Users\Public\Documents\
ChemStation\1\sequence
C:\Users\Public\Documents\
ChemStation\speclib
C:\Users\Public\Documents\
ChemStation\repstyle

All ChemStation logbooks report system messages in an extended format and
information strings are printed over multiple lines. Certain reports, e.g. Sequence
report, may truncate filenames to fit all information onto the report template.

All paths are limited to 260 characters by the Windows operating system. Some
of the characters are invisibly used by the operating system. Therefore you may
need to use shorter names even all specifications listed above are met.

ChemStation Concepts and Workflows
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1 Basic Concepts of OpenLab CDS ChemStation Edition

Software User Interface

The ChemStation user interface is designed into views that group software
functionality according to typical analytical tasks. The following standard views
are present in all software configurations:

« the Method and Run Control view for controlling and acquiring data from the
instrument

+ the Data Analysis view for reevaluating data that has been acquired
+ the Review view for reviewing the data using specific report templates
« the Report Layout view for designing specific report layouts

Additional views are present if additional data evaluation modules have been
ordered or for certain instrument configurations that support instrument
diagnostics and verification procedures.

The Navigation Pane contains the Navigation Buttons, to allow rapid switching
between the ChemStation views, and the tree-based ChemStation Explorer. The
contents of the ChemStation Explorer are view-dependent, giving access to
different ChemStation elements.

Each view consists of a set of standard user elements including menus and
toolbars. The standard toolbar provides rapid access to the common system
specification information such as methods and sequences. The Method and Run
Control view additionally incorporates a system status bar, a sample information
area, which may be configured for single runs or automated runs, and a
schematic instrument interface diagram for GC, CE and LC configurations. The
schematic instrument interface diagram uses hot spots to allow rapid access to
instrument parameters and an animated graphical overview of the status of each
analysis as it proceeds. The schematic instrument diagram may be turned off if it
is not required, to save memory and other Windows resources. The Run Queue
tab also integrated in this view displays all sequences, samples and commands
that are scheduled for the instrument and also allows you to organize and
process this worklaod (see “Using the Run Queue” on page 136).

The Data Analysis view extends the standard toolbar to specific data analysis
modes including recalculation, reprocessing, integration, calibration, reporting,
annotation, signal comparison and additional specialized modes if the modules
are installed. Each of these separate data analysis modes are supported with a
mode-specific toolset.

The Review view is available if Intelligent Reporting is selected for the instrument.
This view allows you to review the data in a very flexible way. You can select any
combination of data files as a basis for the review, and apply any existing report
template to the selected data. The selected report template defines the way in
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1 Basic Concepts of OpenLab CDS ChemStation Edition

which the data is shown and which type of information is included in the
generated report. The toolbar provides functions for printing and exporting the
generated reports.

The Report Layout view allows you to define the layout of a specific report
template or report style. It also uses a set of toolbars specific to this task. The
type of Report Template editor shown in this view depends on the type of
reporting that is configured for the instrument. You can either use Classic
Reporting or Intelligent Reporting (see “Reporting” on page 174).

Navigation Pane

A Navigation Pane, available on the left side of all ChemStation views, is designed
to speed access to many key ChemStation elements, as well as enabling quick
switching between views. The Navigation Pane contains the tree-based
ChemStation Explorer and a configurable button area. It also includes an
autohide feature so that the ChemStation workspace is not compromised, and
offers standard features such as resizing, and re-arranging of the navigation
button area.

Navigation Buttons

The Navigation Buttons allow the ChemStation view to be switched by clicking on
the specific Navigation Button. The Navigation Button section can be minimized,
expanded and re-arranged.

ChemStation Explorer

The contents of the Navigation Pane are view-dependent. For Method and Run
Control, Data Analysis, Review, and Report Layout, the ChemStation Explorer
allows you to navigate to the different ChemStation elements. By default, these
elements for data, methods and sequences are based on the configuration editor
settings. New nodes for methods, sequences, data location can be specified
using the “Preferences” option in the view menu.

Table 3 Navigation Pane items

Navigation Buttons ChemStation Explorer Elements

Method and Run Control Sequence templates / Master methods, Result Set
methods

Data Analysis Data / Master methods, Result Set methods

Review Data / Report templates
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1 Basic Concepts of OpenLab CDS ChemStation Edition

Table 3 Navigation Pane items

Navigation Buttons ChemStation Explorer Elements

Report Layout Classic Reporting: Master methods
Intelligent Reporting: Report Templates

Verification (LC and LC/MS) Verification view-specific shortcuts
Diagnosis (LC/MS) Diagnosis view-specific shortcuts
Tune (LC/MS) Tune view-specific shortcuts

Data Acquisition

The status of the instrument is continually monitored and updated on the display,
along with the elapsed run time of the analysis both when the software is a
visible window and when it is iconized. The transactions that occur during the
analysis, including any errors and the instrument conditions at the start and the
end of the analysis, are recorded in the system'’s logbook, an extract of which is
stored with every data file.

The instrument conditions, such as flow, temperature, pressure and solvent
composition for liquid chromatographs may be recorded and stored with each
data file. These instrument parameters can be displayed and plotted to testify to
the quality of each analysis. The exact nature of the parameters recorded
depends both on the technique and the capabilities of the configured instrument.

All regular data acquisitions - single samples as well as sequence runs - are first
added to the Run Queue and then started from there. For more information, see
‘About the Run Queue” on page 134.

One or more display windows may be used to monitor the data being acquired by
the instrument in real time. The data are displayed in real measurement units
such as mAU, Volts, degrees or bar. The windows may each show multiple
overlaid chromatographic/electropherographic signals or instrument
parameters, such as pressure. The display default settings may be adjusted and
are remembered by the system so users can set their own preferred settings as
the instrument default. The window has zoom capability and the cursor may be
used to display a specific signal's response at any point in time.

During an analysis, the complete functionality of ChemStation can be used
through the offline copy. While acquisition is running, the Data Analysis part of
the online session of an instrument is not accessible, and data review has to be
performed in the offline copy.

ChemStation Concepts and Workflows 18



1 Basic Concepts of OpenLab CDS ChemStation Edition

A snapshot function is available for users who wish to start processing data
before the analysis is completed. The snapshot has to be taken in the offline
copy of the instrument sessions and is immediately present for review.

The layout of the signal and status information windows, including the
components of the schematic instrument interface diagram is saved
automatically.

For further information on Data Acquisition, see “Data Acquisition” on page 68
and the online help system.

Retention Time Locking

Aretention time is the fundamental qualitative measurement of chromatography.
Most peak identification is performed by comparing the retention time of the
unknown peak to that of a standard. It is much easier to identify peaks and
validate methods if there is no variation in the retention time of each analyte.
However, shifts in retention time occur frequently. Routine maintenance
procedures such as column trimming alter retention times. In a multi-instrument
laboratory running duplicate methods, the retention times for each instrument
can differ from each other, even when run under nominally identical conditions.
These differences in retention times will require at a minimum a recalibration
with update of the retention time and may mean that each instrument session
must have a separate calibration and integration event table, making it
time-consuming to transfer methods from one system to another. Differences in
retention time can require additional work when comparing data between
instruments over time.

Retention time locking (RTL) allows a close match of retention times on one GC
system to another system with the same nominal column type (same stationary
phase, column diameter, length, and phase ratio (film thickness)). Using the
retention time/pressure calibration from the initial Retention Time Locking setup,
RTL determines the new inlet pressure needed to update (relock) the GC's
method inlet pressure when an analyte peak has shifted. This locked method can
now be loaded on another GC to update the inlet pressure to match retention
times.
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Data Analysis

Data Analysis — Options

'Classic" Data Analysis is a feature in ChemStation. An overview is provided on
the next pages. For more details, see “Data Analysis” on page 143.

Data Analysis — Display

The ChemStation Data Analysis view extends the standard tool bar with
task-grouped data analysis functions including recalculation, reprocessing,
integration, calibration, reporting, annotation, and signal comparison toolsets.
The following key graphical operations are possible:

single or multisignal displays selectable when loading the
chromatogram/electropherogram,

overlays of chromatogram/electropherogram from different samples,
subtraction of one chromatogram/electropherogram from another,
graphical vertical and horizontal alignment of signals to help visual
comparison,

signal inversion or mirroring to help visual comparison,

displays of extended peak performance characteristics for specific integrated
peaks,

graphical zoom and scrolling functions,

adjustment of display attributes including selection of tick marks, baselines,
axes, retention/migration times and compound names (you can also select
the font for the retention time (RT) and compound labels, adjust the size and

orientation of the display, select the display as overlaid or separated and
select scaling factors),

the chromatogram/electropherogram display may include graphical overlays
of instrument parameters depending on the capability of the configured
instrument,

user-defined annotations may be interactively added to the display, with the
selection of font, size, text rotation and color (once defined, the annotations
may be graphically moved, edited or deleted),

copy the display to the Windows clipboard in both metafile and bitmap
format,

a pick mode function to display the values of individual data points in detector
units, and

export of time/intensity digitized points to the Microsoft Windows clipboard.
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1 Basic Concepts of OpenLab CDS ChemStation Edition

Data Analysis — Integration

The ChemStation integrator algorithm is the second revision of a new generation
aimed at improved ruggedness, reliability and ease-of-use.

Data Analysis — Quantification
The ChemStation’s calibration mode of the data analysis view allows
simultaneous display of:

+ the signal or signals being calibrated with an indication of the current
compound'’s retention/migration time window,

+ the calibration table whose display may be configured from a comprehensive
selection of calibration parameters, and

+ the calibration curve for the compound being calibrated.
All the calibration mode windows are linked so that changes in one are

automatically reflected in all the others. This mode allows graphical selection and
modifications of the calibration data.

Quantification is based on %, Normalized %, External standard, External standard
%, Internal standard and Internal standard % calculations calculated on either
peak area or height. Calibrations may be multilevel and include multiple internal
standard definitions. Calibration histories are automatically saved and can be
used to weight the recalibration calculations.

For information on calibration and quantitation, see “Calibration” on page 160.

Data Analysis — Batch Review

The Batch Review report can be used to review results for each compound for
each sample. It offers the following key graphical operations:

+ define automatic or manual review and reprocess of (calibrated) data files
+ recalibration of calibration table

+ review compound tables of calibrated methods

+ create specific batch reports

The Navigation Table offers several key graphical operations:

+ standard table configuration features, such as sorting, drag-and-drop options,
column selection, item grouping to specify a preferred navigation table
configuration

+ right mouse click functions to load a signal, overlay a signal, export data, print
reports
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+ review signal details by expanding a line in the navigation table
+ review signals and create ChemStation reports using a specific method

Batch Review allows saving manual integration events per run. It is possible to
save manual events with the data file outside of Batch Review. To avoid conflicts
with two sets of manual integrations, any manual events that have been stored
with the data file will not be applied in Batch Review.

There are a few points to watch out for:

+ The recalibration methodology in Batch Review differs from the recalibration
in the original sequence. Pressing the update calibration button on the batch
review toolbar causes the system to recalibrate with all calibration runs in the
batch, creating a recalibrated calibration table. Pressing the Start button on
the Batch Review toolbar will then recalculate amounts for each calibrated
compound. The amounts for all samples will be calculated from the
recalibrated calibration table.

+ Clicking a line on the Batch Review sample table causes the associated data
file to be loaded. Some large data files may take a significant amount of time
to load. This is no different than using Load Signals to load the same data file.

+ The Batch Review report gives results for each compound for each sample.
Because some calibration tables have large numbers of compounds this may
lead to quite large Batch Review reports.

+ Batch Review allows saving manual integration events per run. It is also
possible to save manual events with the data file outside of Batch Review. To
avoid conflicts with two sets of manual integrations, any manual events that
have been stored with the data file will not be applied in Batch Review.

If you use ChemStation with central data storage, the Batch view is by default
disabled. It can be enabled by an entry in the [PCS] section of the ChemStation.ini
file: [PCS] _BatchReview=1. The ChemStation.ini file is located in the C:\
ProgramData\Agilent Technologies\ChemStation directory.

Data Analysis — Recalculation

The functions in the recalculation mode allow you to quickly generate results or
reports for any subset of data shown in the Navigation Table. You can easily
generate results for self-assembled data sets, independent of the sequences the
samples were originally acquired in. You can use any method for recalculation.
The method used will be copied to the single data files (DA.M). No calibration is
done during recalculation.
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Data Analysis — Reprocessing

The functions in the reprocessing mode allow you to reprocess one entire
sequence, using the methods defined in the sequence table and using the results
of the calibration samples to calculate the sample results.

Data Analysis — Last Results

In this mode, the data file method (DA.M) for each run is loaded. DA.M is an exact
copy of the method which was used for the last data analysis (during acquisition,
reprocessing, or recalculation). The Last Result mode allows you to reproduce
the results of the last data analysis, even if the sequence method has been
changed in the interim.

Reporting
With Agilent OpenLab CDS ChemStation Edition, you can choose for each
instrument the type of reporting you want to use:

+ Classic ChemStation Reporting that is unchanged compared to ChemStation
B reporting. For details, see “Classic Reporting” on page 187.

+ Intelligent Reporting: With Intelligent Reporting, you can ...

create report templates with drag and drop ("What you see is what you get"
model)

generate reports in the new Review view by just choosing the data and the
report template

use interactive reports for data review: define the search criteria to select
the information that is relevant for you

generate cross sequence reports

For more details, see “Intelligent Reporting” on page 180.
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Data Export and Import

ANDI

ChemStation can import and export data files in the andi (Analytical Data
Interchange) chromatography format of the Analytical Instrument Association
(AIA), revision 1.0, copyright 1992. Data import is supported at compliance level
one (sample information and signal data) and data export at compliance level
two (sample information, signal data and integration results).

DDE

ChemStation includes commands and functions to support the dynamic data
exchange (DDE) standard of the Microsoft Windows platform as both a DDE
client and a DDE server. The command set includes commands to establish and
terminate connections, transfer information in both directions and execute
remote functions.

ADF

The ADFExport for OpenLab CDS ChemStation tool allows you to export
ChemStation data into the Allotrope Data Format (ADF). The tool is only available
if the corresponding Add-on is installed.

A detailed description of the ADFExport for OpenLab CDS ChemStation tool is
available in the ChemStation ADF Export online help.

Customization

ChemStation can be customized using a powerful command set. These
commands may be grouped to execute automatically a specific function; such a
group is called a macro.

Users writing macros may define their own variables, build in conditional or
looping constructs, perform physical I/0 including file handling and user
interaction, nest their macros and schedule and exchange data with other
Microsoft Windows applications.

Using Custom Commands or Macros in ChemStation

In ChemStation, custom commands can be used at the following locations:
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*  Run Queue
see “Using the Run Queue” on page 136
* Queue Planner
see “Using the Queue Planner” on page 139
* Run Time Checklist
see “Run Time Checklist” on page 48
* Sequence Parameters
see “Sequence Parameters” on page 79
+  Command Scheduler
see “Schedule Commands” on page 140

From each location you can also access the dialog to create or change
commands and macros.
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Create Custom Commands

ChemStation offers several built-in commands that can be used by any user. If
you have the required privilege, you can create your own custom commands and

Mmacros.

You need the privilege ChemStation:Security > Command Line. Privileges are

configured in the Control Panel.

1 From any location where commands can be used, select Set up Custom

Command Template ....

The Custom Command Templates dialog lists all built-in commands and
custom commands that are available for the current instrument type.

“'& Custom Command Templates: Instrument 1

Command

LAMPALL OFF

PUMPALL OFF

Turmn Instrument Standby | Standby

Turn MSD Standby MS55etState STEY

Shut Instrumnent Down | macro "SHUTDOWH.MALC" g0
_[5tate=1

local id$ id=0AddPaused(. 1)
PauseSequence

Turn Spstem On LIDaOperation "TURM_ON"
< m

Display Name

» Turn Lamps Off
Turn Purnps OFf

Fiesume Run Queue
Pauze Run Queue

Pause Sequence

Last Saved Last editby  *
3/29/2018 342338 | SYSTEM
H20/2018 318:19PM | 5YSTEM

m

r

’ Edi... l I Add...

| (oo ]

= B
Applicable far
Aun Queve [FGC
Command Scheduler LC
Post-Sequence command/macro CE
Run Time Checklist LCMS
[E] Pre-Rur Command / Macro CE/MS
[£] Update CustomFields Values
[ Customized Data Analysis Macro
Post-Run Command / Macio

2 Select the required command, then cick Edit....

A dialog opens that allows you to set up the command properties.

+ Display name that is shown in ChemStation to all users.

+ Location where the command will be available (Run Queue, Command
Scheduler, Post-Sequence command/macro, Run Time Checklist of the

method).

 Instrument types for which the command applies.
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£, Edit "Turn Larnps Off": Instrurment 1 E'@
Dizplay name Command
Turn Lamps OFf LatPaLL OFF
Applicable for x
Run Queue

Command 5 cheduler

Post-Sequence command/macro

Run Time Checklist commands:
[] Pre-Run Command ¢ Macro

[7] Update CustomFields values
[ Customized Data Analysis Macio
Post-Run Command / Macro

Inztrument types:

[ GC LCAMS
LC CE/MS
CE

o ][ oot ][t ]

3 Confirm your changes.

Command definitions are saved separately with a method's run-time checklist,
sequence template or a queue plan. That means, if you change or delete a
definition, this is effective only within the scope of where you called the Custom
Command Templates dialog. To apply the change to the dialog in another scope,
you must explicitely update the relevant method checklist, sequence template or
a queue plan.

For more information on customization, see the ChemStation online help on
commands or macros.
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Automation

ChemStation can plan and execute both single samples and multi-method
sequences.

The sequence parameter set may be defined to use automatically generated files
or sequentially numbered files with a user-defined prefix of up to fifteen
characters. The user may select to run full analyses or data reprocessing only
sequences and can also select one of a series of technique specific shutdown
commands (for examples about built-in commands, see “Postsequence
Operation” on page 117) or a user-defined shutdown macro that runs when the
sequence terminates either by error or after all the analyses are completed.

The sequence table, or list of analyses to run, is built in a spreadsheet-like user
interface that allows users to specify vial numbers and sample names, sample
types, analysis methods, sample quantification parameters including sample
amount, a multiplier and dilution factor, calibration specification, data exchange
parameter LIMSID and the number of repeat injections. Depending on the
configured instruments and modules, more fields will be accessible, for example,
if an Agilent 1100/1200 LC system includes a fraction collector, the Fract. Start
column will appear in the sequence table. The appearance of the sequence table
can be configured by the user. The user can jump between individual cells in the
table and copy, cut or paste individual cells or entire rows or series of rows in
order to build sequences efficiently and quickly.

Samples may be identified in the sequence table as unknown, calibration, blank,
or control sample types. The sample type determines any special data evaluation
treatment of the sample:

+ Unknown samples are evaluated and reported according to the method
specification.

+ Calibration samples are used to recalibrate the quantification component of
the method as described below.

+ Blank samples are used to evaluate the reference signal for specific peaks, as
defined by European Pharmacopeia. You can print the signal-to-noise ratio in
customized reports. Please refer to the Reference Guide for details on the
calculation and the required data fields.

+ Control samples are evaluated against the limits for each component defined
in the method. If the results lie outside any specified parameter range the
execution of the sequence will be halted.

Calibration samples may be defined as simple, cyclic or bracketed. Simple
recalibrations mean a recalibration occurs each time a calibration sample is
defined in the sequence. Cyclic recalibrations occur at defined intervals during
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analysis of a series of unknowns. In bracketing a series of unknown samples, two
calibration sets are analyzed. The quantitative reports for the unknown samples
are then calculated using a calibration table averaged between the two
calibration sets.

The Sequence Preview functionality allows users to see the order of execution of
the sequence. As soon as the sequence is queued, the sequence table also
shows all samples run by run. The user can select individual sample entries to
rerun or re-evaluate. When re-evaluating data that was already acquired, users
can specify whether reprocessing uses the original sample quantification data or
new data entered in the sequence’s sample table.

Sequences may be paused to run single injection priority samples by another
method, then restarted without disrupting the automation. Samples can be
added to the sequence table while the sequence is executing.

Both the sequence and partial sequence tables may be printed.

For more information on sequences, see "Automation/Sequences” on page 76,
and the online help system.

Run Queue and Queue Planner

The Run Queue allows you to automatically run several single samples or
sequences one after another. The first item added to the queue starts when the
data system is ready, unless paused from the queue. You can add single
samples, sequences based on Easy Sequence templates, classic ChemStation
sequences, or pauses to the queue. Also each Run Method or Run Sequence
command automatically adds an item to the Run Queue, and automatically starts
this item in the queue.

Using the Queue Planner, you can prepare a series of single samples or
sequences and save the plan to the file system. To start these planned samples
and sequences, you simply open the plan and add it to the Run Queue. This
function allows you to start lengthy tasks such as overnight or weekend jobs.

For more information, see “About the Run Queue” on page 134.
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Sample Locations

A graphical control allows you to pick the vial locations for your injections and for
fraction collection.

Instead of typing the sample location manually, which requires a deep knowledge
of the correct addressing format, you simply choose the drawer location, tray
type, and vial location with a mouse click.

The graphical control to select sample locations is integrated in the following
dialogs and toolbars:

« Sample Info

* Sequence Table

* Filldown Options

+ Fraction Collector (Start Position)

« Purify taskbar in the Data Analysis view

The control contains the following elements:

Sample Location: 1 [™00ials™) m w  [blank mn if no entry)

Sampler (Full Tray) \l}

Sample name; T1 - Azzsigned Container: w1 00ials*

Multiplier:

Comment:

Blank

Custonn Figlds ... Containers at 'T1" are not dcjy azsignable. They are auto-detected by the device.

Figure 1 Sample location picker in the Sample Info dialog

1 Initial input field for the sample location. Click the arrow or press F4 to open the graphical
control, or enter the location string manually.

2 Graphic that visualizes the layout of the sample container device (injector or fraction
collector). If several container locations are available, click to select one.

3 Visualization of the selected sample container. Click a sample location to select it and
close the graphical control.
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4 Additional locations, as defined by the driver. For example, Blank for samplers, or Next
Location, Next Plate, Pooling for fraction collectors. Click to select the location and close
the graphical control.

5 List of containers that are compatible to the selected device location.
Use Current Configuration selects the container as determined by the device/driver
configuration at the time of injection.
Use <empty>, for example, for fraction collector layouts to ensure that a container is not
considered in the collection order during execution.

There are primarily the following workflows:
+ Use current configuration

This is the default approach. When the sample or sequence is executed, the
system automatically detects the device.

+ Assign container to be applied on acquisition

This workflow is for definable containers that cannot be detected by the
system, for example, plates. You specify which container has to be used when
the sequence or sample is executed.

+ Assign container to be validated

This workflow is for non-definable containers that are automatically detected
by the device, for example, trays. When the sequence or sample is executed,
the system validates the specified container. If the physical container does
not match the specified one, the run will be aborted. This ensures that the
correct container type is used.

+ Prepare unassigned container

This workflow is for containers that are filled in advance but are not yet
inserted into the sampler. They are assigned to a drawer and position at a
later point in time.

The graphical sample locations control is supported, for example, by the Agilent
LC RC.Net drivers.
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Good Laboratory Practice

ChemStation is developed to internationally recognized design and development
standards and has a number of features specifically to help users operating in a
regulated environment. These features are in the area of complete method
specification and verification that the methods are fit for their intended use, to
check the operation of their system and ensure the traceability, originality and
quality of the data.

Development Process

The Certificate of Validation shipped with each software package documents the
software development and testing steps executed as part of the development
cycle. The development process is registered to the ISO 9001 quality standard.

Method Specification and Use

+ Global methods — the complete instrument and data analysis specification is
stored in one place. Methods include individual compound range
specifications to check that quantification results are not applied outside the
calibrated range.

+ The method change history log allows users of a validated method to
automatically record how and when a method was changed. Users may
optionally add a comment reason to the change history log. The change
history log is automatically stored as part of the method in a binary format. To
prevent unauthorized access to the records, it is protected by the user access
scheme, described below. The change history log may be viewed and printed.

+ Limits may be assigned on a compound-by-compound basis in each method
for a number of chromatographic/electropherographic and system
performance parameters, as described in the data analysis quantification
section. Results exceeding these parameter ranges are used to control the
execution of automated sequences as described in the automation section.
They are indicated on the appropriate analysis report.

« System performance or suitability reports (see the Reporting section above)
provide detailed analysis of the separation quality.

You can set up different roles and privileges in OpenLab Shared Services. The
pre-configured roles ChemStation Administrator, ChemStation Lab Manager,
ChemStation Analyst, and ChemStation Operator offer a basis for the roles in your
environment.
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Method Robustness

Sequence summary reports (see “Classic and Intelligent Reporting” on page 179)
provide a means to test methods for robustness. With classic reporting, the
extended format reports for user selected criteria are reported as trend charts
and may be used to determine the realistic operation limits. With intelligent
reporting, you can create your own templates for sequence summary reports
including trend charts with limit lines. These limits can then be incorporated in
the method to ensure, through the analysis of control samples, that the method
is operating within specifications.

System Operation

The ChemStation verification kit, which is part of the standard software,
automatically checks for the correct installation and operation of the data
evaluation parts of the software by comparing results generated when the test is
executed against prerecorded known values. The verification kit allows users to
define their own data files and methods to be the basis of the test.

Data Traceability, Originality and Quality

The run time logbook provides a transaction log of the complete system. It also

records any unusual events (such as errors or parameter changes made during a
run) as well as the instrument conditions before and after each analysis. A copy

of the relevant logbook extract is saved with each data file.

The actual instrument conditions, such as pressure, flow, and temperature, that
occurred during each analysis are also recorded if the configured instrument
supports this capability. This data can be subsequently displayed graphically with
the chromatogram/electropherogram to show the actual instrument conditions
during that particular analysis, as well as being included on the report.

Methods saved with the data file record the actual method at the time of the
analysis and allow the complete reconstruction of the reported data at a later
date. The method is saved at the completion of all the analytical steps.

By default, all reports have time stamps and traceable page numbering (page x of
y pagination style). The user may select the level of detail in each report ranging
from simple summary reports to complete system details.

GLP Save register files, specified as part of the method configuration, save all the
original data, including sample information, data analysis method,
chromatographic/electropherographic signals, instrument conditions, integration
and quantification results, report data and the run logbook in one checksum
protected binary file. This is an uneditable binary format that ensures the
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originality of the results. The file includes a revisioning scheme that indicates if
data has been reprocessed.

Control sample types may be defined in the sequence table and used to
automatically check the instrument performance against quality control sample
results when the instrument is running unattended. Results that are outside the
user-specified acceptable range will stop the automatic execution of the
instrument.
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Preparative Liquid Chromatography

ChemStation supports the automation of purification and preparation workflows.
The typical workflow includes using a fraction collector with fraction pooling.

a®
s®se
ox” . Crude product and sample information
B . o
[ .|
‘ Target confirmation and analytical scouting
]
= i Purification
_—
TTETERITT Purity determination of collected fractions
2 Fraction pooling and reformatting
>
|
Purity determination of pooled fractions
o

(V] Archive or screening

Purity determination of collected fractions

In order to check the purity of your collected fractions, you can convert them into
samples and add them to a sequence for re-injection. The list of fractions for the
re-analysis is created in the Collect fractions for re-injection dialog accessible via
the Purify toolbar in the Data Analysis.
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In the dialog table, you set up the list of fractions for generating the sequence,
and you can specify the method and the sample location.

Fraction list

Method

Sequence

Location

Fractions can be added by selecting them from the
chromatogram, the fractions table, or the sample container
graphic.

A drop-down list shows all methods stored on the computer. If
your method is on another instrument that you will use for
re-injection, you can type the method name in the field, or keep it
blank for later.

You can create a new sequence using the Create from new
sequence template option. You can also append the fractions to
an existing sequence using the Create from existing sequence
template option.

If you intend to transfer the sample container to a different
instrument for re-injection of the fractions, select the Convert
sample locations to parking lot locations check box.

This converts the locations in the table to neutral parking lot
locations that can be used on a different sampler.

Depending on the setup, the sequence can now be executed, or edited again in
the Sample List of the Sample Entry tab. For more information, see “Graphical
Sample Entry” on page 80.

Fraction Pooling

Pooling is the collection of multiple fractions into the same collection vessel.
ChemStation supports different pooling options:
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+ Inject several times from the same sample position, and collect into the same
vessel(s)

In the Sample Info dialog, choose the required number of runs for the single
sample, and select a fixed fraction start location for the first run.

+ Inject from different sample positions, but collect into the same vessel(s)

To configure pooling, set the fraction collector start location for the first run and,
if required, for the following runs.

Fraction Collector Delay Calibration

The time a compound needs to travel between the point of detection in a detector
and the point of collection in a fraction collector is called delay time. It can be
determined by performing a delay time calibration.

The Delay Calibration Wizard guides you through this process of performing and
evaluating a fraction collector delay calibration. The wizard is accessible in
Instrument menu of the Method and Run Control view.

First, set up and run the delay calibration using Perform Delay Calibration Run.
Then evaluate the results of the delay calibration using Evaluate Delay Calibration
Data. The delay calibration is summarized in the Delay Calibration Summary
report.

The data evaluation assists with working out the delay between the peak
detector(s) and fraction collector module(s). Delay times are determined based
on detector signals and the fraction collector's delay sensor signal of a
calibration run data file. Delay volumes are calculated based on flow information.

For more information, refer to the ChemStation online help.
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ChemStation Data Structure

In order to strengthen the association between data files and methods, the usage
of result sets has been introduced with ChemStation B.02.01 (result sets have
been called sequence containers then):

« The data is stored with all necessary information needed for data analysis:
copies of the sequence file, of all methods, and in case of Intelligent Reporting
also of the report templates employed with the sequence. The sequence
methods can be changed with sequence specific input and do not influence
the original master method. The result set concept thus strengthens the
meaning of a sequence as a set of data files and methods belonging together
for result creation.

+ Sequence data are not overwritten. Each sequence acquisition stores the
resulting data files in its own result set with unique name.

+ Data recalculation and reprocessing are both available in Data Analysis view
via the Navigation Table.

+ If you use a central data storage system (OpenLab ECM 3.x, OpenLab ECM XT,
or OpenLab Server), the complete result set (sequence/methods/data
files/report templates) is transferred to the central repository as one entity.

<data_file1>.D
<data_file2>.D DAM

<data_file3>.D

Sequence Method
<seq_name>.S
<seq_name>.B
<seq_name>.log

Report Templates

\ 4 / <templ_name>.RDL

Result Set

Figure 2  Sequence Acquisition
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The methods in the folder ChemStation\x\methods' serve as master methods.
They remain unchanged during acquisition and data analysis.

Similarly, the sequences in the public documents folder ChemStation\1\
sequence serve as sequence templates that can be used to rerun (but not
reprocess) a sequence several times.

Report Templates in the public documents folder ChemStation\REPSTYLE serve
as a starting point for developing your own report templates.

The data storage pattern varies depending on whether single run data or
sequence data is acquired:

1 When a sequence is executed, a new folder is automatically created (result
set) with a unique name in the specified subdirectory. When a single sample is
run, the data file (*.d) is written to the specified subdirectory.

2 For sequence data, the executed sequence template (*.s) and all the methods
(*.m) involved are copied into the result set. The copies of the methods are
called the sequence methods in order to distinguish them from the original
master methods. If you use Intelligent Reporting, all involved report templates
(*.rdl) are copied into the result set as well.

All sequence-related tasks (for example, acquisition and data analysis) are
performed on the copies of the sequence and the methods. Therefore, the
sequence template and the master methods remain unchanged for future
sequence execution.

Any changes performed on the sequence during sequence acquisition, for
example, adding lines to the sequence table, are performed on the copy of the
sequence file in the result set. The sequence template remains unchanged.

Similarly, any changes in the method, for example, updates in the calibration
table in case of calibration runs, are reflected in the sequence methods, but
not in the master methods.

While executing the sequence, all generated data files (*.d) are stored in the
sequence data folder, along with the corresponding batch file (*.b) and
sequence log file (*.log).

3 Each data file contains a copy of the method used to create the run. The
following method information is stored:

To view the original method parameters for each specific data file, right
click the relevant line in the navigation table, then select View ACQ Method.

1 xis the instrument number. The folder is under public documents by default but can be

configured during installation.
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ChemStation offers to save a copy of the complete method (RUN.M) after
each run (see “Save Copy of Method with Data” on page 67).

A copy of the data analysis parameters (DA.M) is always saved (see “Save
Copy of Method as DA.M with Data (ChemStation Default)” on page 67).

Secure Workstation

ChemStation Edition is available in a compliant flavor: Secure Workstation for
OpenLab CDS ChemStation Edition combines ChemStation Workstation and
Content Management on one PC.

In order to comply to 21 CRF Part 11, Secure Workstation provides secure data
storage, and offers various audit trails and logbooks, such as:

the method audit trail,
+ theresults audit trail, or
the sequence audit trail.
For more information on the Secure Workstation for OpenLab CDS ChemStation

Edition, refer to the Secure Workstation for OpenLab CDS ChemStation Edition
Users' Guide.
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Remote Instrument Control

With a distributed system configuration, you can configure and launch your
ChemStation instruments from any OpenLab Control Panel that is connected to
the OpenlLab Shared Services server.

L aunch Instruments

To configure or launch your instruments, you can use the Configure Instrument,
Launch online, and Launch offline buttons in the OpenlLab Control Panel. As in
workstation or networked workstation configurations, the instrument
configuration dialog runs on the local PC. However, with a distributed system
configuration, the ChemStation application itself runs on an Analytical
Instrument Controller (AIC) machine, and you access the application via a
Remote Desktop connection to the AIC machine.

The remote ChemStation windows are shown independently of the OpenlLab
Control Panel; you can launch an instrument, close the Control Panel, and
continue working with the instrument. Also you can run multiple instances of
Openlab Control Panel on the same client using different logon credentials. The
different credentials will be propagated to the instruments you launch from the
corresponding OpenlLab Control Panel.

You can identify the instruments running on a remote AIC machine by the
window title, which contains both the instrument name and the AIC name.

Session Disconnect

Instruments running on an AIC are independent of the client from which you
opened the Remote Desktop connection. If the client disconnects, for example,
due to network failure, a sequence running on the instrument continues
unaffected. To regain control over the instrument session once the network has
recovered, simply click the Launch online or Launch offline button again.

To disconnect intentionally, click on the Close button or select File > Exit. The
Close dialog offers an additional Disconnect button. By disconnecting, you cut off
the Remote Desktop connection while leaving the instrument running.

You can disconnect the Remote Desktop connection while a sequence is
running.
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To reconnect to this instrument session, simply click the Launch online or Launch
offline button again in the Openlab Control Panel. You can reconnect from any
Openlab Control Panel that is connected to the OpenlLab Shared Services server.

If you click Launch offline to reconnect to an online instrument, or vice versa, you
will get two instrument windows, one for the online instrument and one for the
offline instrument.

Session Takeover

You can take over an existing session by clicking the Launch online or Launch
offline button in the OpenLab Control Panel on a different PC:

+ If you launched an instrument from the OpenlLab Control Panel on PC 1, then
log on to an OpenLab Control Panel on PC 2 with the same user credentials
and launch the same instrument there, you simply take over your existing
session and continue on PC 2 with whatever you started on PC 1.

No warning is shown if the new user and former user have the same
credentials.

« If another user has launched the instrument from the Openlab Control Panel
on a different PC, and you have the required privileges, you can also take over
that session. You must have the Take over ChemStation Remote Session
privilege, and if the other user has privately locked the ChemStation, you must
also have the Break Session Lock privilege. For more information on user
management, privileges, or session lock configuration, refer to the OpenLab
CDS ChemStation Edition Configuration Guide (CDS_CS_configure.pdf).

The current lock status of an instrument/session is shown by an icon to the
left of the user name in the used by field of the Instrument panel and the used
by column in the Instruments table:

% The instrument/session is being used by another user; do not take it over.

EI The instrument/session is locked privately; do not take it over.
|

r The instrument/session is either locked non-privately or is disconnected; it is available for
another user to take over.

If you take over the session, the other user receives a message stating which
user has taken over the session.

The report displays both the Acquisition Operator who is logged on as the
current user and the Sample Operator who submitted the single sample or
sequence to the Run Queue.
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Online and offline instruments are included in the same session and are therefore
always transferred together. If an online instrument and an offline instrument are
already launched in a session, the takeover transfers control of both instruments,
regardless of whether you clicked the Launch online or Launch offline button. If
you click Launch offline and the session comprises only an online instrument, or
vice versa, you will get two instrument windows, one for the online instrument
and one for the offline instrument.

Force Shutdown

To shut down non-responsive instruments that cannot be used anymore, you can
right-click the instrument in the OpenLab Control Panel, and select Force
Shutdown from the Control Panel on the CDS Client.

You must have the Instrument Administration privilege to use this function.

Forcing a shutdown will not immediately update the instrument status, leading to
a temporary inconsistent status display until the status is automatically reset to
'not started". It is recommended that you wait at least two minutes before
launching a new ChemStation session.
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The method is a vital part of ChemStation, and this chapter explains the concepts
in detail.
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What is a Method?

A method comprises all the parameters for acquisition and data analysis
together with pre- and post-run tasks for a given sample, if they are needed.

The available methods (*.m) files are visible in the ChemStation Explorer. For
quick and easy navigation, you can add additional method locations to the
ChemStation Explorer selection tree using the Paths tab of the Preferences dialog
box.

There are different types of methods. Depending on the storage location,
methods are either used as master methods, as a reference within the result set
of a sequence, or as an actual record of the settings used during data acquisition.

Master Methods

These are methods stored on the computer disk. Stored methods have a name
with up to forty alphanumeric characters followed by the extension *.M. The
master method directories are configured in the Preferences (see "Path
Selection” on page 69).

The Master Method is stored in a methods subdirectory, available in a Methods
node of the ChemStation Explorer, and is not directly associated with any result
set.

Sequence Methods

When a sequence is run, copies of all the master methods used in the sequence
are stored in the result set along with the sequence data files. These methods are
directly linked to the sequence, and are also used when the sequence is
reprocessed. Changes to these methods are by default not automatically
propagated to the master methods. Changes take effect as soon as the
sequence run starts or continues after a pause. Changes are also propagated to
the data file methods (DA.M) when the sequence is reprocessed, and on any
report generation.
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Data File Methods

A copy of the data analysis parameters is stored as the data file method DA.M
with the data files. The data file method DA.M is automatically updated after
each result generation (data acquisition, recalculation or report generation). It is
also loaded by ChemStation when you recalculate results in the Last Result
mode (see “Last Result Mode” on page 147).

If you use the Save method with Data option in the run time checklist, the method
is stored additionally as run.m in the data file.

In the ChemStation Explorer, you can easily load either a master method or a
sequence method by double-clicking on the method item.
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Parts of a Method

A method is identified by a name of up to forty alphanumeric characters. The file
name always has the .M extension to identify it as a method. Methods are stored
as directories that contain individual files relating to the components of the
method.

Each method comprises four components:

* method information,

* instrument control,

+ data analysis, and

* run time checklist.

Method Information

This section is used to define descriptive information about the method.

Instrument Control

Defines parameters that control the instrument or its components. With an LC
instrument, parameters, such as mobile phase composition, flow rate, injection
volume, detector wavelength, and so on, control the pump, the injector and the
detector. With a GC instrument, parameters such as inlet temperature, inlet
pressure, packed column flow setting, and so on control the instrument.

Data Analysis

Defines parameters that control the data processing.
+ Signal Details

Defines signals and their properties used for data evaluation.
* Integration Events

Defines timed events that will occur at specific retention/migration times on a
chromatogram/electropherogram. These timed events can be used to
change the way the signal is integrated.

* Peak Identification

Defines data processing parameters associated with the identification of
peaks in the chromatogram/electropherogram.
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* Peak Quantification

Defines data processing parameters that affect the quantification
calculations which determine the amount or concentration of sample
component corresponding to each peak.

« Calibration and Recalibration

Defines data processing parameters that affect the calibration and how often
calibration is done.

* Custom Fields

Defines the properties of sample or compound related custom fields that are
available for the method. The custom fields allow you to add custom
information to a sample or a compound in a sample.

*  Report

With Classic Reporting: defines the format of the report that is printed after a
run.

With Intelligent Reporting: specifies the report template used to generate the
report after a run.

Run Time Checklist

Defines which parts of the method are executed when the method is run.

You can use the run time checklist to:

* acquire, store and process data to produce a report,

+ execute only a portion of the method,

+ acquire and store data without analyzing it,

+ reanalyze existing data files,

+ use your own commands for data analysis, pre- and post-run processing,
+ save the analysis results in a register for GLP purposes, and

+ save your method together with the data.

For more information about custom commands and how to set them up, see
“Using Custom Commands or Macros in ChemStation” on page 24.
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Creating Methods

Creating a new method always means modifying a master method or sequence
method and saving the modifications. You can either overwrite an existing
method, or save a method as a new master method. Be aware that when you
change a method, the disk version remains unchanged until you save your
changes.

You have a choice of how to create a method. You can create a method to do
either one or all parts of an analysis. For example, you can create a method to do
only data acquisition. When you are ready to analyze the data and generate a
report, you can then modify the method to do these data processing tasks.

Do not delete the default method (DEF_LC.M, DEF_CE.M or DEF_GC.M). These
method files are used as templates to create new methods.
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Editing Methods

You can edit an existing method using the Edit Entire Method item of the Method
menu. You are guided through all the method dialog boxes and at the end you
can save the method. This process is shown below:

Method on disk
|

\

Load Method

Method loaded into memory, becomes current method
|
| |

Select 'Edit Entire Method' from the Method menu

¥
Edit Method

\/
Save Method [As]
|

Save to new name Save to same name

v
Creates new method Overwrites current method
on disk

Figure 3  Editing Method

Method Parts to Edit

Each method comprises four components that can be edited separately.
Some of the following subsections refer to specific dialog boxes, and some are
generalized descriptions.
*  Method Information comprises:
a text description about the method.

« Instrument Control depends on the configuration, and can comprise, for
example:
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oven parameters,
injector parameters, and
detector parameters.
+ Data Analysis comprises:
signal details,
integration parameters,
quantification parameters,
calibration parameters,
custom field setup parameters, and
reporting parameters.
* Run Time Checklist comprises:
the parts of the method that will be executed.

Method Directory Structure

Folders

A method comprises a group of files stored in the method directory (*.M). By
default, master methods are stored in the instrument's method directory. This
directory is, for example, in the public documents folder C:\Users\Public\
Documents\ChemStation\x\METHODS, where x is the instrument number.

The path to the instrument can be defined during installation. Additional paths for
master methods can be added using the preference settings.

Use ChemStation menu File > Open Windows Explorer... to open the instrument's
data directory (for example, C:\Users\Public\Documents\ChemStation\1).
Alternatively, use the shortcut to Instrument Data in the Start menu.

Sequence methods are stored in the result set, and data file methods are stored
as DA.M in the data file subdirectory.
Files

Method files with the .MTH extension contain parameter sets and are in
UNICODE format. The file INFO.MTH comprises the method control parameters.

Method files containing the instrument parameters have the name of the related
analytical module. For example:
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Table 4 Method file examples

HPCE1.MTH Comprises the acquisition method for the Capillary
Electrophoresis.

ADC1.MTH Comprises the Agilent 35900 acquisition method. If two identical
instruments are configured, the method files are called
ADC1.MTH, ADC2.MTH.

DAMETHOD.REG For data evaluation.

LALS1T.REG Comprises parameters for the Agilent 1100/1200 Series
autosampler when a classic modular LC system is configured. The
method files for the other Agilent 1100/1200 Series modules
follow the same convention Lxxx1.reg where xxx is the module
acronym.

AgilentSamplerDriver1.Rapid ~ Comprises parameters for the Agilent 1100/1200 Series

Control.xxx.xml autosampler when a modular LC system is configured. Several
xml files are present for the various parts of the parameters
(indicated by the xxx part of the file name). Similar .xml files are
available for the other modules.

Editing Methods in Online Mode

When an online ChemStation is idle, you can edit all parts of a sequence method.
When a sequence is currently running, you can edit all acquisition parameters
and some of the Data Analysis parameters, such as the settings under Specify
Report.

The changes are saved and immediately set into effect for the current run and all
following sequence lines that include the same method. This means that you can
also change the method during a sequence pause or a partial sequence.

Editing Methods in Offline Mode

You can edit a sequence method in an offline ChemStation, while the same
method is used for a run in an online ChemStation. In this scenario, you can edit
the Data Analysis part in the offline session. Once you save the changes in the
offline session, the changed DA settings will be used for the next Data Analysis of
the current sequence run within the online session.
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Method updates concerning calibration are not taken into account. Also history
entries are not merged, that is, if a method is running in an online session, and
you change it in both online and offline session, the audit trail of the method will
only contain the changes made in the offline ChemStation.

If the same master method is loaded in online and offline ChemStation of the
same instrument, you can only edit the method in the online ChemStation.
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Administrating Methods

Methods Tree in ChemStation Explorer

The Methods Tree in the ChemStation Explorer is divided into two parts. The
upper part shows the methods contained in the currently loaded result set. The
lower part shows the methods in the master method directories, which you
configure in the Preferences dialog.

Data Analysis n
Sequence Methods ’

=-aa# C:\Users\Public\Doc...ta\DemoLC_Demol
L) LC_Demo.M

Master Methods £
E-aa# C:\Users\Public\Documents\Chemst. ..
-{] Batch.M

-] def LC.M

-] DemoCall.M

-] DemoCal2.M

-{)) DGALSTst.M

-[)) DGCalAs.M

-] DGCaloQLM

-[)) DGCaloQ2.M

-] DGCaloQ3.M

-] DGCalog4.M

-[)) DGCalogQ5.M

-[)) DGCalogs.M

-] DGCalPs.M

[} DGCHPTst.M

-[)) DGCPTest.M 18

m

Data| Methods

The currently loaded method is always shown in bold.
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By Drag & Drop you can easily copy master methods to sequence methods. The
entire method (DA parameters and ACQ parameters) will be copied to the result
set.

Viewing the Acquisition Method

You can access the Acquisition Method Viewer via the menu Instrument >

Acquisition Method Viewer... in the Method and Run Control view. The Acquisition
Method Viewer is available for both Online and Offline ChemStation sessions.

With the Acquisition Method Viewer, you can check the acquisition parameters
stored in a method, independently of the current instrument configuration. The
dialog shows the instrument configuration at the time when the method has
been saved in ChemStation. Data analysis parameters are not shown in this
viewer. The Acquisition Method Viewer does not allow the user to make any

changes to the loaded ChemStation method.

The Acquisition Method Viewer shows the method settings in read-only mode. It
does not provide functionality to edit and save methods.

| Acquisition Methed Viewer
(@ Change Root... ()] View Method ~

Method: Infinity-Checkout.M | ™, Injection Source: HipAls

- C:\Users\Public\Documents'Chem!
Demo
) Batch M
) def_LCM
i) DemoCali M
-] DemoCalz M
-] DGALSTstM
() DGCalAS M
) DGCaloQ1.M
) DGCaloQz.M
) DGCal0Q3.M
) DGCal0Q4.M
) DGCa0Q5.M
(i) DGCal0Q6.M
--{if) DGCalPS.M
) DGCHPTst.M
() DGCPTest M
+-{) DGFLDTst.M
-] DGLeakT M
i) DGNoise M
(i) DGNPTest M
) DGTHMTst.M
{i) DGVWDDC.M
w
) lsocra.M
) IsoPlot.M
) LoadTest.M
- MuttiSig.M

Q‘\\Me«hoc -

o

n

o n

r

& 1290 Infinty DAD | g 1290 Infirity TCC | < 1290 Infinity ALS | <3 1230 Infinity ALS Injector Program | £ 1290 Infinty BinPump { 3'
A4

A Advanced

©)

1290 Infinity DAD (G4212A)

n

m

Loaded Method: C\Users\Public\Documents\ChemStation\1\Methods\Infinity- Checkout.M @

Help ] [

Close

Figure 4  Acquisition Method Viewer dialog
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1 Method browser
2 Toolbar
3 Module tabs (It shows method settings, pretreatment settings in a tab-control for all found

modules in the used instrument configuration)

4 Method viewer area
5 Method Name, Injection Source Info
6 Status bar

In the method browser (1), the preferred method path is shown by default. Click
Change Root... in the toolbar to select a different directory.

The toolbar (2) offers the following View Method options:

+ View with Original Configuration.... Load the settings as stored in the method to
the instrument.

+ View with Instrument Configuration...: Apply the stored method to the current
instrument configuration. This option is available for Online instruments only.
The stored method might not be consistent with the current instrument
settings; if possible, the settings are then automatically adapted, otherwise,
you can check the details in the Method Resolution Info dialog. This dialog
shows the list of inconsistencies and the differences between unresolved and
resolved method.
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Method Resolution Info @

List of Inconsistencies:

¥ml schema wersion mismatch (xml version: 1.0.3, expected version: 1.0.5) -
Tpgrade from xml schema wersion 1.0.3 to wersion 1.0.4

Upgrade from xml schema wersion 1.0.4 to wersion 1.0.5

Tze Zolvent Types is set but not supported in current configuration

Parameters for 3troke Mode are set, but not supported in current configuration.
Parameters for Compressibility B are set, but not supported in current configquration.
Parameters for Primary Channel are not set.

Parameters for Max. Flow Ramp Down are set, but not supported in current conficuration.
Parameters for Expected Mixer are set, but not supported in current configquration.
Parameters for Chamnell Solvent are set, but not supported in current configquration.

Tarama tave Far Chorwmal? Salmant ava oar  bir wmor ounmarrad Gn cuyeont cowfdemvard o

m

Lizt of Changes:
Operatian Change D escription o
Changed ent Types from Yes

Deleted Deleted Stroke Mode with value Synchronized
Deleted Deleted Compressibility Mode B with value Compressibility Value Set
Deleted Deleted Compressibility B with value 73 10e-6/bar =
Changed Changed Solvent Compogition from Channel A, Used: Yes, Percentage: 0, Selected: Ch. 1, Mame: , Type: Aqueous ta Channel A, ...
Changed Changed Solvent Composition from Channel B, Used: 'es, Percentage: 50, Selected Ch. 1, Mame: , Type: Organic ta Channel B, Us...
Changed Changed High Preszure Limit from 1200.00 bar to 600,00 bar
Added Added Primary Channel with value Automatic =
Deleted Deleted Max. Flow Ramp Dovwn with value 10.000 mL/miré B

Figure 5 Method Resolution Info dialog

Updating DA Parameters in the Master Method

The Update Master Method option is available from the Method menu and from
the context menu of the sequence method in the ChemStation Explorer. The
availability and exact behavior of this function depends on the current mode. In
all cases, this function updates the data analysis parameters of the target
method.

Itis important to note that this feature updates the data analysis parameters only
of the target method, and that it overwrites all data analysis parameters.

Updating a Master Method in Reprocess or Recalculate Mode

In this mode, the Update Master Method command is only active for sequence
methods of a result set. You can update the master method that you referred to
when creating the sequence. The precondition is that the master method still
exists in the master methods directory (the master method must have the same
name as the sequence method).
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You can also configure the sequence parameters to automatically execute this
function during each sequence acquisition or reprocessing. For more
information, refer to “Administrating Methods” on page 54.

Updating a Master Method in Last Result Mode

In this mode, the Update Master Method command is active for both sequences
and single samples. You can transfer the current data analysis parameters to the
master method last used for data analysis. This method is shown in the Analysis
Method column of the Navigation Table.

The command is available under the following conditions:

« The method file exists in the given location (that is, the name and the entire
path must match).

+ For sequences: The sequence run has been manually analyzed with a master
method (not with the sequence method).

Updating Any Master Method in Last Result Mode

In Last Result Mode, you can transfer the data analysis parameters to any master
method, independently of the master method related to the current sequence or
single run. To update any master method, select Menu > Update any Master
Method ..., and select a method from the Choose Master Method to update dialog.
The data analysis parameters will then be copied to the selected master method.

Updating Methods

With the Update Methods dialog (see figure below), you can copy methods from
the master method directory to the result set and vice versa. In both cases, the
entire method is copied (DA parameters and ACQ parameters).

You can open the dialog from the Method > Update Methods... menu or from the
context menu of the sequence method in the ChemStation Explorer. The function
is available for result sets in Recalculate and Reprocess mode.
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Figure 6 Update Methods dialog

Update Methods
Master Methods @ Sequence Methods @
Method Last saved o Method Last saved
-{] DGCalPs 4f5/2004 6:16:49 PM - C:\Users\Public\Documents\ChemStation}1\Data
{J) DECHPTst 1/14/2005 11:17:51 AM ) RIE Demo 1/28/2014 10:55:496 AM
-{{) DGCPTest 462004 6:16:57 PM
-{{|] DGFLOTst 4f6/2004 6:17:09 PM
{{) DGLeakT 4{6/2004 6:17:20 PM
-{( ] DGNoise 4/6/2004 6:17:29 PM
-{J) DGNPTest 4f6/2004 6:17:36 PM
-{J{) DGTHMTst 1/31/2006 10:09:38 AM
-{{] DEYWDDC 4f6/2004 6:17:53 PM
{4 Infinity-Checkout 8/31/2009 1:33:10 PM
-{] Isacra 2/27/2006 5:29:26 PM
-{J[] IsoPlot 4f6/2004 6:18:18 PM @
{{) LoadTest 4f6/2004 6:18:31 PM
-] MultiSig 4/5/2004 6:18:42 PM
{1 Purity 45/2004 6:18:43 PM
-{{{) RRLC-LowDelay 2(27/2006 5:06:24 PM
.{J{) RRLC-StdDelay 2/27/2006 4:45:43 PM
) SysPerf 4f6/2004 6:18:57 PM
-] SysSuit 4{6/2004 6:19:11 PM
-+ dDemo
{) DemoADC 10/28/2005 2:31:55 PM
--{{]) DemoAFC 11/2/2005 4:06:33 PM
{1 DemoFLD 10/28/2005 2:34:05 PM
{1 DemavwiD 10/23/2005 2:34:37 PM
{1 ESTD 10/13/2005 4:28:57 PM
{1510 10/17/2005 3:55:03 PM
-{|) SpecsiHZ 10/28/2005 2:34:50 PM
C:\Users\Public\Documents\ChemsStation\IMethods\Demo
[7] Show enly commeon methods
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On the left side, you see the methods in all master method directories (as configured in the
Preferences).

On the right side, you see the methods in the currently loaded result set.

For each method, you see the date when it was last saved. The tooltip of the date shows
the method's last history entry.

Methods can also be stored in subfolders of the master method directory.

Read-only methods have an [R] prefix. The currently loaded sequence method is shown in
italics.

Methods that are common for the sequence result set and the master method pool are
shown in a bold font. The methods are matched only by name; if a method name exists in
more than one pool each of the instances will be considered common.

You can copy methods between a master method pool and the sequence result set either
by using Drag&Drop or by using the < and > buttons. You cannot overwrite methods that are
marked as read-only.
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Saving a Method as New Master Method

You can save the data analysis parameters from DA.M as a new master method.
However, the DA.M does not contain acquisition parameters. To provide a valid
set of acquisition parameters for the new master method, you must therefore
select another method as a template for the acquisition parameters (see figure
below). The new master method will then contain your current data analysis
parameters from the DA.M, and the acquisition parameters from the selected
template method. The new method will be created in the folder where the
acquisition template method is located.

Save As Mew Master Method
Erter new master method name:
Acqueition Template Method:
Method Last saved o
~HafC\Chem32', 14 METHODS
-] BATCH 4/6/2004 £:10:00 PM
[0 [RIDEF_LC 1/1/1570 1:00:00 4M
- | ) DEMOCALL 46,2004 6:11:09 PM
- [) DEMOCALZ 4f6)2004 6:11:19 PM
-] DGALSTST 4/6/2004 £:15:20 PM
{0 DaCALAS 4/6/2004 £:15:43 PM
- DECALCQL 46,2004 £:16:00 PM
-] DGCALOQZ 46,2004 6:16:11 PM
-] DECALOQ3 46/2004 6:16:15 PM
-] DGCALCQ4 4/6/2004 6:16:26 PM
{1 DECALOGS 4/6/2004 £:16:33 PM
- ) DECALCQE 416/2004 £:16:40 PM
-] DGCALPS 4/6/2004 6:16:49 PM
-] DGCHPTST 1/14/2005 11:17:51 AM
-] DGCPTEST 4/6/2004 6:16:57 PM
) DGFLDTST 4/6/2004 £:17:09 PM
- ) DGLEAKT 416/2004 £:17:20 PM
-] DGMOISE 416)2004 6:17:29 PM
-] DGMPTEST 4/6/2004 6:17:36 PM
-] DETHMTST 1/31/2006 10:09:35 AM
- DEVWWDDC 4/6/2004 £:17:53 PM
=L ) INFIMITY-CHECKOUT  8/31/2009 1:33:10 PM
Ciichem32 1\ METHOD S, -
[ oK ] l Cancel I l Help I

Figure 7 Save as New Master Method dialog
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What Happens When a Method is Run?

The Run Time Checklist dialog box specifies the parts of the method to execute
when a run is started.
There are the following parts to the run time checklist:
* pre-run command or macro,
data acquisition,
+ standard data analysis,
analysis method for second signal (GC only),
+ update custom fields values,
customized data analysis,
+ save GLP data,
post-run command or macro, and
+ save copy of method with data (RUN.M).
When running a method the specified parts of the method defined in the Run

Time Checklist dialog box are executed. Use the menu Method > Run Time
Checklist... to display or edit the specified parts of the Run Time Checklist.

For more information about commands and how to set them up, see “Using
Custom Commands or Macros in ChemStation” on page 24.

Method Operation Summary

The following list shows the flow of the method operation when all parts of the
Run Time Checklist are selected.

1 Prerun Command Macro
Does a task before the analysis is started.
2 Data Acquisition
Does injector program.
Injects sample.
Acquires raw data.
Stores data.
Saves the acquisition parameters in the ACQ.TXT file.
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3 Optional, as directed by the Run Time Checklist: Save Copy of Method with
Data as RUN.M.

4 Data Analysis (Process Data)

Loads data file.

Integrates data file.

Identifies and quantifies peak.

Searches spectral library if available.

Checks peak purity if available.

Saves a copy of the method (DA.M).

Prints reports (after updating custom fields values, if selected).
5 Update Custom Fields Values

Executes your macros to update custom fields values before reports are
printed.

6 Customized Data Analysis

Executes your macros after reports have been printed.
7 Save GLP Data

Saves binary register GLPSave.Reg
8 Postrun Command Macro

Does a task after completion of the analysis, for example, generates a
customized report.
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ChemStation status

Postrun macro

Data evaluation

Injection

Save RUN.M
(optional)

Prerun macro

Prerun -

Raw data
file closed

Save DAM
(default with report generation)

I

I

I

I

I

I

!

Y

Status levels

Run method started via ChemStation menu

Figure 8

Method operation

Time

The figure below shows an overview of the ChemStation status during the
method operation, where all parts of the Run Time Checklist are selected.

Pre-run Command or Macro (Run Time Checklist)

If a pre-run command or macro is specified, it is executed before the analysis is

started. This part is typically used for system customizing in conjunction with

other software packages.
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Data Acquisition (Run Time Checklist)

+ All parameters are set to the initial conditions specified in the current method.

+ If specified the injection program is executed and an injection is made from
the currently defined vial.

The monitor display shows the progress of the analysis including
chromatographic/electropherographic information, and spectral data if
available.

+ Data are acquired and stored in a data file.

«  When the Data Acquisition is finished, the acquisition parameters of the
currently executed method are stored as ACQ.txt for the data file by default.

Data Analysis (Run Time Checklist)

When the stop-time has elapsed, the analysis is finished and all raw data is
stored on the computer’s hard disk. The data analysis part of the software starts
when all the raw data is stored.

Integration

+ Chromatogram/electropherogram objects in the signal are integrated as
specified in the Integration Events dialog box.

The start of the peak, the peak apex, retention/migration time and the end of
the peak are determined.

Baselines are defined under each peak to determine final peak height and
area.

+ The integration results are created as an Integration Results list.

Peak Identification and Quantification

Using retention/migration times and optional peak qualifiers, the software
identifies the peaks by cross-referencing them with known components
defined in the calibration table.

+ By using peak heights or peak areas the software calculates the amount of
each detected component using the calibration parameters specified in the
Calibration Table.
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Spectra Library Search (for LC 3D, CE, CE/MS and LC/MS Systems Only,
Available With Classic Reporting)

For all peaks that have UV-Visible spectra available, an automated search of a
predefined spectral library may be done to identify the components in the sample
based on the UV-Visible spectra. See Understanding Your Spectral Module for
details.

Peak Purity Checking (for LC 3D, CE, CE/MS and LC/MS Systermns Only)

For a peak with UV-Visible spectra, you can calculate a purity factor for that peak
and store it in a register. Peak purity may be determined automatically at the end
of each analysis as part of the method, if the Check Purity box is checked when
specifying an automated library search or when selecting an appropriate report
style. See Understanding Your Spectral Module for details.

Print Report

A report is generated with identities and amounts of components detected in the
run.

If you run an Update Custom Fields macro, reports will be generated after this
macro has been executed.

Update Custom Fields Values

ChemStation allows to define custom fields for a sample and for specific
compounds. These custom field values can be included in your reports. By
default, the values are static. Update Custom Fields Value enables you to modify
the custom fields values before reports are generated. The updated fields are
available in both Classic and Intelligent Reporting.

An exmaple macro is available in the Disk2 > UCL folder.

Your Update Custom Fields macro will be executed as follows:

1 asa part of a Standard Data Analysis, shortly before reports are created

2 every time on creating a report/report preview in the Data Analysis view (even
if Standard Data Analysis is not selected in the Run Time Checklist)
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During reprocessing, the custom fields values are always overwritten with the
static values defined in the sequence/sample. The custom fields will be modified
only shortly before reports are generated. Therefore, if you reprocess a sequence
with a different method that does not contain the Update Custom Fields macro,
the values will be reset to the defined static values.

Customized Data Analysis

Enables you to run your own customized macros to evaluate your analytical data.

With Standard Data Analysis enabled, these macros run after reports have been
generated. Results are therefore not available for reporting (neither Classic nor

Intelligent Reporting). With Standard Data Analysis disabled, they run after data
acquisition.

Save GLP Data

Saves the binary register GLPSave.Reg together with the data analysis method in
the data directory. This feature is designed to help prove the originality of the
data and the quality of the individual analysis.

The GLPSave.Reg binary file contains the following information in a non-editable,
checksum-protected, register file:

« key instrument set points (can be graphically reviewed),

+ chromatographic or electropherographic signals,

+ integration results,

+ quantification results,

+ data analysis method, and

+ logbook.

These data are saved only if the Save GLP Data feature is activated by checking

the check box in the runtime checklist. You can review, but not edit, GLP data in
the data analysis menu of ChemStation.
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Postrun Command or Macro

If a postrun command or macro is specified it is executed after the data
evaluation, for example, copying data to a disk for data backup.

Save Copy of Method with Data

This is done after data acquisition, and only if Save method with Data is activated
in the Run Time Checklist. It copies the method used for acquisition to the data
directory, named as RUN.M. RUN.M contains DA and ACQ parameters. It is
read-only and thus provides a means for you to reconstruct the analysis in the
future even if the method changes in the meantime. You can see how changes in
the method or in selected parameters have influenced your analysis, which can
help you to optimize it.

Save Copy of Method as DA.M with Data
(ChemStation Default)

Independently of the marked items in the Run Time Checklist, a copy of the data
analysis parameters of the executed method is saved as DA.M along with the
report in the data file. This is done at the end of the Standard Data Analysis part,
and also when you create a report in the Data Analysis view.
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Status Information 73
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This chapter contains an introduction to the process of acquiring data.
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3 Data Acquisition

What is Data Acquisition?

During data acquisition, all signals acquired by the analytical instrument are
converted from analog signals to digital signals in the detector. The digital signal
is transmitted to ChemStation electronically and stored in the signal data file.

Path Selection

Flexible data storage for single runs and sequences allows you to specify various
saving locations without reconfiguration. The Paths tab in the Preferences dialog
box in the View menu gives you the opportunity to add multiple paths in addition

to the default path!C:\Users\Public\Documents\ChemStation\x\DATA (where x
is the instrument number). Using the Add and Remove buttons, existing paths
can be deleted, or you can navigate to a selected location and add the path into
the Preferences.

The default path cannot be removed from the list, but it can be changed in the
Configure Instrument dialog from the Control Panel. For more information on
changing the default paths, refer to the Openlab CDS ChemStation Edition Guide
for Administrators.

The ChemStation menu File > Open Windows Explorer... povides easy access to
the actual instrument's data directory (for example, C:\Users\Public\Documents\
ChemStation\1). Alternatively, use the shortcut to Instrument Data in the Start
menul.

1 Path can be defined during installation.
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Figure 9  Paths tab in the Preferences dialog

All newly specified Data Paths are then available for selection in the Sample Info
and Sequence Parameters dialog boxes when performing runs.
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Figure 10 Data path selection in the Sequence Parameters dialog

ChemStation Concepts and Workflows 70



3 Data Acquisition

Online Monitors

Online Signal Monitor

The online signal monitor allows you to monitor several signals and, if supported
by the associated instrument, instrument performance plots in the same
window. You can conveniently select the signals you want to view and adjust the
time and response axes. For detectors that support this function a balance
button is available.

You can display the absolute signal response in the message line by moving the
cross hair cursor in the display.

Online Spectra Monitor

The online spectra monitor shows absorbance as a function of the wavelength,
or m/z for mass spectra. You can adjust both the displayed wavelength range
and the absorbance scale.
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Logbook

The logbook displays messages that are generated by the analytical system.
These messages can be error messages, system messages or event messages
from a module. The logbook records these events irrespective of whether they
are displayed or not.
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Status Information

Status Bar

The graphical user interface of the ChemStation system comprises toolbars and
a status bar in the Method and Run Control View of ChemStation. The status bar
comprises a system status field and information on the currently loaded method
and sequence. If they were modified after loading they are marked with a yellow
asterisk or cogwheel, depending on the instrument. A yellow EMF symbol points
to usage limits that exceed the setpoints set for LC consumables (for example,
the lamp). The status bar also shows the status of the Run Queue, which can be
Resumed, Paused, or Blocked.

System Diagram

If supported by the configured analytical instruments (for example, the

Agilent 1200 Infinity LC Series modules, or the Intuvo 9000 GC system) you can
display a graphical system diagram for your ChemStation system. This allows
you to quickly check the system status at a glance. Select the System Diagram
item from the View menu of the Method and Run Control View to activate the
diagram. It is a graphical representation of your ChemStation system. Using the
color coding described below the current status is displayed.
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Status Information
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Figure 11 System diagram, for example for a GC

Table 5 Colors used to indicate the status of the module or instrument

Color Status

gray offline

green idle

orange not ready

red error

cyan standby (for example, lamps off)
purple pre-run, post-run

magenta injecting

blue running or post-run

In addition, you can display listings of actual parameter settings. Apart from a
status overview, the diagram allows quick access to dialog boxes for setting
parameters for each system component.

See the instrument part of the online help system for more information on the
system diagram.
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Rules and Alerts

For instrument drivers that support this feature (for example, GC 7890A), you can
choose Instrument > Manage Rules and Alerts... to configure how the
ChemStation will react to specific events during acquisition.

For example, a missing vial or vessel is a common error in chromatography. The
ChemStation may, for example, continue, pause, stop, or abort a sequence.

The covered events and the possible behaviors depend on the instrument driver.
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Preferences - Sequence Tab 109

Data File Structure 110

Data File Naming in a Sequence 112
Automatic Data File Naming in a Sequence 112
Entering Data File Names Manually 113

Using a Prefix/Counter to Name Data Files 113
Using a Name Pattern to Name Data Files 114
Result Set Migration 115

Postsequence Operation 117
Not Ready Timeout (LC and CE only) 117
Wait Time (LC and CEonly) 118

Automatic Recalibration 119

Specifying Recalibrations 120
Recalibration Parameters in the Sequence Table 120

Types of Sequences 122

Explicit Calibration Sequences 122

Cyclic Single-Level Calibration Sequences 122

Cyclic Multiple-Level Calibration Sequences 123

Explicit and Cyclic Calibrations Together 125

Cyclic Calibration Sequences with Bracketing 127

Cyclic Recalibration Sequences with Multiple Vials Containing the Same
Dilution of a Standard 131

This chapter describes the concepts of automation. It explains how to work with
sequences in ChemStation, what happens when a sequence is run and how to
customize sequences.
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What is Automation?

Automation is the unattended analysis of more than one injection.

The sequence part of the ChemStation software allows you to automate
acquisition, data evaluation, and report generation.

What Are Seqguences and Sequence Templates?

A sequence is a series of instructions that automates the analysis of samples. It
can be used to automatically inject each sample, and to acquire and analyze the
data according to the method specified for that sample. Each sample vial in a
sequence may be analyzed with a different analytical method and, thus, use
different sets of chromatographic/electropherographic conditions and
evaluation parameters.

Sequence files (*.s) are"sequence templates” that can be used to run an
acquisition multiple times; however, these templates are not used for
reprocessing in Data Analysis. When the sequence template is run, a result set is
created, containing all related files. If you reuse the sequence template,
ChemStation creates a new result set for each reuse.

The available sequence templates are visible in the ChemStation Explorer. For
quick and easy navigation, you can add additional sequence template locations
to the ChemStation Explorer selection tree using the Paths tab of the Preferences
dialog box.

It is possible to set up multiple sequences for an instrument and schedule them
in an appropriate order. The Run Queue tab displays the total workload for the
instrument (sequences as well as single samples, pauses, etc.). You can define
the order of items to be processed directly in the Run Queue tab. For more
information about the Run Queue, see “About the Run Queue” on page 134.
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Sequence Parameters

The Sequence Parameters dialog box contains information common to all sample
vials in a sequence. Use this dialog box to:

+ select the data directory using the Path combo box,

+ specify how the sequence processing should be done by choosing particular
part of Methods and Run parameters, and

+ specify what happens when the sequence is finished, for example, by using a
Shutdown command macro. For more information about custom commands
and how to set them up, see “Using Custom Commands or Macros in
ChemStation” on page 24.

For example, you can choose to either:
+ execute the run time checklist,
+ do acquisition only, or

« do reprocessing only (for data acquired till ChemStation Rev. B.01.03. or for
data acquired with option Unique Folder Creation OFF).

Sequence data acquired with ChemStation revisions up to B.01.03 or acquired
using the options Unique Folder Creation OFF need to be reprocessed using the
reprocess option in the Method and Run Control view.

Sequence data acquired with ChemStation revisions B.02.01 and higher need to
be reprocessed using the reprocess option in the Data Analysis Navigation table.

If the reprocess option is selected, you have the choice to use the sample data
defined when the sample was originally analyzed, or by activating the Use
Sequence Table information check box, you can use updated sample data by
entering new data in the sequence table:

« specify if the barcodes should be used in the sequence and how to handle a
barcode mismatch, assuming that a barcode reader is installed on the
system.
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Graphical Sample Entry

Starting with ChemStation C.01.07, an intuitive graphical sample entry is
supported, that is based on a visual display of the Sample Container and the
loaded samples. You can either manually create new samples, or load existing
sequences for which you want to assign parameters that do not yet exist, such
as a method or a container location (for example, for re-injection sequences
generated from collected fractions).

Sample Containers refer to instrument trays or plates that hold samples/vials.
Sample containers have different dimensions and different vial capacity
depending on the instrument. Sample Container types describe the physical
properties of a specific tray or plate in an XML format. Custom Sample Container
types can be centrally stored and made available across the lab by importing an
XML file containing the sample container type definition. The Import Sample
Container Type button in the Openlab Control Panel is used to import the custom
Sample Container types.

You can choose a sample container in the Sample Entry tab. You can easily create
new sample entries in the graphical user interface, simply by clicking in the
container visualization. The sample locations will be color coded corresponding
to the sample type.
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Figure 12 Sample entry tab
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The Selection Properties (@) allow you to define the pattern for multiple samples.
Using these options, you can display the ordering arrow. Simply drag the mouse
over several locations.

Figure 13 Ordering arrow

For all autosamplers that physically allow rearranging of plates, you can even
drag entire plates to other positions or drawers . The vial locations are
automatically adjusted in the sample list. The container configuration can be
saved with the sequence template, or exported to PDF.

You can also prepare plates that are not associated with any specific position or
drawer. These parking lots correspond to the plates you prepare on your bench.
They are saved together with the other settings in the sequence template. You
can load this sequence template at a later point in time for the relevant
instrument, and then assign the prepared plates to the correct position and
drawer.
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Figure 14 Multisampler in the Sample entry tab

The Sample List table offers many functions that help you editing the table, such
as:

+ Copy cell ranges

« Append copied cells or line